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CHAPTER 1
Welcome

Welcome to the Web TimeSheet Integration Manager for Microsoft Project Standard/Professional User 
Guide. Throughout this user guide, the Web TimeSheet Integration Manager for Microsoft Project Standard/
Professional will be referred to as the Integration Manager.

About the Integration Manager
The Integration Manager allows users to transfer project and task information, project team assignments, 
and timesheet data between Web TimeSheet and Microsoft® Project® Standard/Professional easily and ef-
ficiently. Once installed, the Integration Manager is accessible from the Tools menu within Microsoft Project.

The Integration Manager allows one-way transfer of timesheet/hours data from Web TimeSheet to Microsoft 
Project. Bidirectional data transfer is available for project/task information and project team assignments. Bi-
directional project/task information includes:

• Project/task structure
• Project manager
• Task estimated cost, with roll-up to the parent level
• Task start and end dates
• Resources/users

The project start and end dates can be transferred one way, from Microsoft Project to Web TimeSheet (these 
dates are automatically determined in Microsoft Project based on the task start and end dates).

Technology
The Integration Manager uses streaming XML (Extensible Markup Language) technology and Microsoft 
Project Object Model to update data between Web TimeSheet and Microsoft Project.  The Integration Man-
ager establishes a link with both the Web TimeSheet database and the Microsoft Project database and 
transfers data depending on the specified criteria.

About this User Guide
This user guide provides information on using the Integration Manager.  The information is organized into 
chapters and a table of contents is provided for quick reference.

Document Conventions
This manual uses the following conventions:

• References to other areas in the document are shown in italics and in blue to indicate they are 
active links internal to the document.  To automatically navigate to the section being referenced, 
select the link.

• Hyperlinks to websites or e-mail addresses are shown in blue and underlined to indicate they are 
active links external to the document.  To open a new browser window to the website or to send an 
e-mail to the address, select the link.
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• Key information is highlighted using a blue background for quick reference.  An icon is used to indi-
cate the type of information being provided, as follows.

• The  icon indicates a note, which provides a reminder of an important requirement or 
further details on how the software operates.

• The  icon indicates a warning notice.  Warnings point out features or actions that can 
have negative results if used incorrectly.

• The  icon indicates a tip or hint designed to assist you in using the product more effi-
ciently.

Contacting Support
If require further assistance configuring or using the Integration Manager, please contact Replicon's Cus-
tomer Support team using one of the following methods:

Direct Phone: 403-262-6519 ext 3

Toll-Free Phone:
North America: 1-877-862-2519
Europe/New Zealand: 00-800-8622-5192
Australia 0011-800-8622-5192

E-mail: support@replicon.com

Web-Based Form: www.replicon.com/Support/RequestHelp.aspx

Fax: 403-233-8046

The online help system uses these same conventions for easy identification of important 
notes, warnings, and tips.
Welcome 6
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CHAPTER 2
Getting Started

This chapter provides information on where to download the Integration Manager, starting the module once 
it is installed, troubleshooting connection issues, understanding log files, and accessing the online help.

Downloading and Installing the Integration Manager
The Web TimeSheet Integration Manager for Microsoft Project can be downloaded from within the Integra-
tions section of Web TimeSheet. Refer to the Integrations chapter in Web TimeSheet’s online help for in-
formation on installing the integration module.

Starting the Integration Manager
The Integration Manager must be installed on your local computer in order to transfer data. Once installed, 
you can access the Integration Manager following the steps below:

1. Launch Microsoft Project and open a project file.
2. In the Tools menu, select Web TimeSheet Integration...

A Setup for Web TimeSheet Integration Manager window displays.
3. In the Microsoft Project Configuration section, if you are using:

• Project 2003/2002, specify the Microsoft Project .MPD File that contains the projects 
you want to update.
Projects to be transferred from Microsoft Project 2003/2002 to Web TimeSheet must be 
saved to a Microsoft Project database file (.MPD file).

• Project 2007, specify the Folder for Microsoft Project Files that contains the projects 
you want to update.
Microsoft Project 2007 saves projects using the .MPP file format only, therefore you must 
select the folder where project’s .MPP files will be transferred to or from (not an .MPD file).

4. In the Web TimeSheet Connection section, enter:
• The Web TimeSheet URL, which is the URL used to access Web TimeSheet on the server 

(required the first time you log in). If you are unsure of the URL, check with your system 
administrator.

Automatic Updates...
As of Version 4.4, the first time you launch the integration module after an upgrade becomes available, 
your version will be automatically upgraded.

Ensure only one version of Project is open before opening the Integration Manager.

If the Integration Manager is not available from the Tools menu, use the standalone version 
which can be accessed from the Windows Start menu.

To automatically use the same folder (2007) or .MPD file (2003/2002) each time, within the 
Integration Manager’s Configuration tab, save your settings to a configuration file, then se-
lect that file as the default Load Configuration File. For information on how to save your set-
tings, refer to Saving Transfer Settings on page 16.
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• The Login Name and Password you normally use to log into Web TimeSheet.
• If you wish to bypass the setup window in the future, enable the Remember this informa-

tion check box.
5. Select the OK button to connect to Web TimeSheet. If the connection is successful, the Integration 

Manager will open in a new window. If the connection fails, refer to Possible Reasons for Connection 
Failure on page 8 below for more information.

Possible Reasons for Connection Failure
If you are unable to connect to Web TimeSheet, the Integration Manager will display an error message indi-
cating the reason why the connection failed. Possible reasons for a failed connection include:

• User Name/Password Error
Your user name does not exist, your user profile has been disabled, or your password is invalid. If 
you cannot resolve the issue on your own, please contact your Web TimeSheet administrator.

• License Error
You do not have a valid license key and/or seat assignment for the Web TimeSheet Integration 
Manager for Microsoft Project Standard/Professional, or your license key has expired. Please con-
tact your Web TimeSheet administrator for further information.

• Server Connection Error
The server location is invalid, or there is a problem connecting to the Web TimeSheet server. 
Please contact your system administrator for further information.

• Interrupted Connection
The connection to the Web TimeSheet server has been interrupted. The Integration Manager will 
automatically try to reconnect before requiring feedback. If you receive this error, you may choose 
to retry, or cancel the connection and try again later.

You can change your setup information later, if necessary, from the Integration Manager’s Configu-
ration tab. For more information on how to do this, refer to Chapter 5, Modifying Configuration Set-
tings Information on page 23.

When you launch the Integration Manager on subsequent occasions – depending on what versions of 
Microsoft Project you have installed and open – you may be prompted to:

• Select which version of Project to use
• Open the selected version
• Close the version you are not using.
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Understanding the Integration Manager Log Files
The Integration Manager generates a log file that are available for viewing at any time:

Accessing the Online Help
The Integration Manager includes an online help system that provides comprehensive information on using 
the software to complete key tasks, as shown below.

Log File Name This file is typically located at... Contains all information logged...

MSPIlog.txt In XP or earlier:
C:\Documents and Set-
tings\<logged-in user's 
name>\Local Settings\Applica-
tion Dataa\Replicon\Integra-
tion Manager for Microsoft 
Project

In Vista:
C:\Users\<logged-in user's 
name>\AppDataa\Local\Repli-
con\Integration Manager for Mi-
crosoft Project

a.  Application Data and AppData are by default hidden folders, so you will have to enable the Show hidden
files and folders option in your operating system to view them. To find this option in Windows XP or earlier,
select Tools > Folder Options... > View. To see this option in Vista, select Organize > Folder and Search
Options > View.

... before the Integration Manager logs in 
to Web TimeSheet (for example, infor-
mation regarding login failures)
AND
all information logged after the Integra-
tion Manager connects to Web 
TimeSheet (for example, information on 
all events that occurred during the trans-
fer process, including errors encoun-
tered and items that were not updated 
due to problems with Web TimeSheet 
editing permissions)
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To access the online help, select the Help button in the bottom, right hand corner of the main Integration 
Manager window.
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CHAPTER 3
Transferring Data

The Web TimeSheet Integration Manager for Microsoft Project Standard/Professional allows you to transfer 
data between Web TimeSheet and Microsoft Project Standard/Professional.

This chapter provides information on:

• Setting up the Integration Manager before performing a transfer. For more information on this topic, 
refer to Setting Up the Integration Manager on page 11.

• Saving transfer settings. For more information on this topic, refer to Saving Transfer Settings on 
page 16.

• Performing a transfer. For more information on this topic, refer to Performing a Transfer on page 
17.

Setting Up the Integration Manager
Before you can transfer data (using the procedure described under Performing a Transfer on page 17), you 
first need to specify some setup options to ensure that the proper data is updated and the field mappings 
are appropriate.

To set up the Integration Manager, you must:

1. Select the direction of transfer, and the projects you would like to update. For information on doing 
this, refer to Selecting General Update Settings on page 11.

2. Select the data you would like to update. For information on doing this, refer to Selecting Data to 
Update on page 12.

3. Perform resource mapping, if required. For information on doing this, refer to Performing Resource 
Mapping on page 15.

4. Perform field mapping. For information on doing this, refer to Performing Resource Mapping on 
page 15.

Selecting General Update Settings
Select the direction of transfer and which projects you would like to update using the General tab.

Selecting the Direction of Transfer
Use the Select Direction To Update Data field (of the General tab) to select one of the following options:

Once you have set up a data transfer, you can save your settings and use them for future transfers, 
or as a starting point for making modifications to the settings. You can save multiple data transfer con-
figurations.

• For information on saving your settings, refer to Saving Transfer Settings on page 16.
• For information on loading a previously-saved configuration file, refer to Chapter 5, Modifying 

Configuration Settings Information on page 23.

To prevent data conflicts, when transferring from Web TimeSheet to Microsoft Project, start and end 
dates, task duration and type, and time entries are NOT updated for projects and tasks that have sub-
tasks ("child" tasks).
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• Transfer data from Microsoft Project to Web TimeSheet
• Transfer data from Web TimeSheet to Microsoft Project

Selecting Projects to Update
Use the Select Projects To Update field (of the General tab) to select the projects you want to update. If 
you are transferring data:

• From Web TimeSheet to Microsoft Project, you can select any number of the projects available 
within Web TimeSheet. If you would like only projects with Open status in Web TimeSheet to dis-
play, enable the Hide closed projects check box.

• From Microsoft Project to Web TimeSheet:
• Using Microsoft Project version 2007, you can select any number of projects from the 

Project Folder selected on the Configuration tab.
• Using Microsoft Project version 2003/2002, you can either select any number of projects 

from the .MPD Project File selected on the Configuration tab.

To select projects to update:

1. Select the Refresh List button to ensure the list of available projects is up to date.
2. Select a project, or multiple projects, from the Available Projects list on the left. To select multiple 

projects, hold down the Ctrl key while selecting the project names.
3. Select the  button to add the selected projects to the Selected Projects list on the right.

Selecting Data to Update
Specify the types of data you would like to transfer using the Select Data to Update tab. Depending on the 
direction of transfer, only certain options outlined in the procedure that follows will be available. 

Selecting Task Hours to Transfer
If you are transferring from Web TimeSheet, enable the Update Task Hours check box if you want to include 
task hours in the update. Task hours cannot be transferred from Microsoft Project to Web TimeSheet. Only 
hours that meet all selected criteria will be updated.

To select task hours to transfer to Project:

1. From the Approval Status field, select one of the following:

If you would like only projects with Open status in Web TimeSheet to display, enable the Hide 
closed projects check box. When this option is enabled, all closed projects will disappear 
from both the Available and Selected projects lists.

Web TimeSheet projects assigned multiple clients using the Bucket method or Project cost 
allocation options will not be listed as available for transfer.

The Integration Manager does not support the transfer  – in either direction  – of projects that have 
been assigned multiple clients using the Bucket method or Project cost allocation options.

When updating for the first time, update all hours within the project start and end dates to ensure all 
the necessary data is available in both applications.
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• All hours (regardless of whether the time has been committed/approved)
Use this option if you have a short project cycle or deadlines that fall outside the usual 
timesheet due dates

• Approved hours
Use this option if your project has a longer cycle (one for which the estimate vs. actual val-
ues do not require constant comparison).

2. Select the Date Range for the task hours, if applicable. The date range options are:
• All 

Transfers all dates for which hours have been entered into Web TimeSheet for the project. 
If any of these dates fall outside of the estimated project start and end dates set in 
Microsoft Project, they will be included in the transfer, and the project start and end dates 
will be automatically updated to include these dates.

• From/To (date range) 
• Timesheet Period
• Time Data of

Select one of the following options:

Time will be updated only for resources who are set up explicitly as members of the 
project team in Web TimeSheet (not members who receive their assignments via an 
<All> or department assignment).

If you have added resources to your project, you should perform an update for the 
project structure/resources before attempting to update any time.

Option Transfers time entered...

Current Week From the most recent Sunday to the 
day prior to the transfer date. For ex-
ample, if you transfer data on 
Wednesday, data from Sunday to 
Tuesday will be included.

Previous Week For the week – spanning Sunday to 
Saturday – previous to that of the 
transfer date.

If the transfer day is a Sunday, select Previous Week. If you select Current Week, 
the time period will include zero days and no data will be transferred.

If the Integration Manager cannot read the users’ weekly days off from the Project cal-
endar (as occurs when Project 2007 is used), the days off are assumed to be Satur-
day and Sunday.

Transfers automatically adjust to use data from the selected relative time period. 
Therefore, you do not need to adjust the date with each transfer.
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3. From the Transfer field, select to transfer one of the following:
• Only modified and new time cells

• All time cells

Selecting Other Data to Update
Under Advanced Settings, select any other types of data you would like to update by enabling the appro-
priate check boxes.

The available options are:

When updating hours from Web TimeSheet to Microsoft Project, the Integration Man-
ager calculates the total actual work for the project. The Work field will not be affected 
by these calculations because this field is automatically calculated by Microsoft 
Project based on multiple variables.

For information on how the Integration Manager handles transfers involving duplicate user names in 
Web TimeSheet, refer to Understanding how Duplicate Users are Transferred on page 21.

Option Name When enabled, transfers... Notes

Update 
Project/Task 
Structure

• Project and task names
• The task sort order
• Additional project/task information 

seected in the field mapping
• Project start and end dates

This data is updated by default during the 
first transfer in either direction.

Update 
Project Man-
ager

• The Manager field in Project 
(located on the File > Properties > 
Summary tab)

to or from...
• The Project Leader field in Web 

TimeSheet

Transfer of this field is successful only if the 
manager:
• Is present in the Web TimeSheet User 

list
• Has Manager permissions  
If you enable this option, you must specify 
the name format in the Resource Name 
Mapping field. For information on name for-
mats, refer to Chapter 4, Mapping Resourc-
es on page 19.
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Performing Resource Mapping
If you are transferring resources or users between Web TimeSheet and Project, the Integration Manager will 
use a resource name mapping formula to match users with resources.

Resource name mapping is required for all resource or user transfers, whether you are transferring resourc-
es or users as part of a project (as outlined in the table above), or from a resource pool file (available for 
transfers to Web TimeSheet only). Mapping is also required if the Integration Manager is creating new users 
or resources who do not yet exist in the destination application.

For information on setting the resource name formula, and configuring and understanding other resource 
transfer options, refer to Chapter 4, Mapping Resources on page 19.

Performing Field Mapping
Once you have selected which data you would like to transfer, you must then map applicable fields in Web 
TimeSheet to their corresponding fields in Microsoft Project, or vice versa. You can set up mapping relation-
ships for only one update direction at a time – the update direction you selected on the General tab.

To set up a mapping relationship:

1. Select the Field Mapping tab.

Update Task 
Start Date

• The project or task's Start date field 
in Project (located on the File > 
Properties > Contents tab)

to or from*...
• The Time Entry Start Date field in 

Web TimeSheet

* If you are transferring a project from Web 
TimeSheet to Microsoft Project, start and 
end dates:
• ARE updated, if it is the first transfer of 

that project. If you do not enable these 
options, the date of transfer will be 
transferred to these Project fields 
instead

• ARE NOT updated, if it is the second 
(or subsequent) transfer of that project. 
Not updating these fields in this direc-
tion prevents data conflicts.

Update Task 
End Date

• The project or task's Finish date 
field in Project (located on the File > 
Properties > Contents tab)

to or from*...
• The Time Entry End Date field in 

Web TimeSheet

Update 
Project Team

• Employees who are project 
resources in Microsoft Project

to or from...
• Employees who are members of the 

Web TimeSheet project team

You may choose to transfer one of the fol-
lowing:
• Only the resources for a project team  

will be created in the Web TimeSheet 
User list

• The resources and their task assign-
ments will be created in the Web 
TimeSheet User list and they will be 
assigned to the appropriate project/task

If you enable this option, you must specify 
the name format in the Resource Name 
Mapping field. For information on name for-
mats, refer to Chapter 4, Mapping Resourc-
es on page 19.

Option Name When enabled, transfers... Notes
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2. If you are using Project 2007 and you want to map custom fields, enable the Allow mapping of Mi-
crosoft Project custom fields check box.

3. From the drop-down list on the left, select a source application field name. This list contains all the 
available fields in the source application.

4. From the drop-down list at the right, select the destination application field to map to the selected 
source field. Once selected, a field is no longer available for mapping.

5. Select the Add button. The selected fields will display in the Selected Mapping Relationships list 
box.

To remove a mapping relationship, select the relationship from the Selected Mapping Relationships list 
box and select the Remove button. 

For information on the available mapping relationships, refer to Chapter 6, Field Relationships on page 25.

Saving Transfer Settings
The data transfer settings you have selected can be saved to a file which can be loaded into the Integration 
Manager to restore the configuration settings to the saved values.

A configuration file can also be specified as the default and automatically loaded when the Integration Man-
ager starts.

The data transfer settings are saved in a configuration file with the extension .XML. The following settings 
are saved in the configuration file:

To save the current configuration settings:

1. Select the Save button. A Save Settings to File window displays.
2. Navigate to the location where you want to save the configuration file.

This option exists for performance reasons, since each .MPP project file must be opened 
when mapping custom fields for Project 2007. Mapping of custom fields is always allowed for 
those using Project 2003/2002 since only one file (the .MPD) must be opened during custom 
mapping for Project 2003/2002.

If you regularly perform several different types of transfer, create a file for each configuration and load 
each as required.

Tab where data was selected Data saved in the configuration file

General The direction of data transfer
The projects selected for transfer

Select Data to Update All options selected

Resource Mapping All options selected

Field Mapping All field mappings selected

Configuration The Resource Pool Configuration set-
tings selected 
If using the standalone version, the Project 
File Configuration specified
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3. In the File name field, enter a name for the configuration file.
4. Select Save. A message box indicating that the settings have been saved displays.
5. Select OK to close the message box.

To load the settings saved in a configuration file into the Integration Manager:

1. Select the Configuration tab.
2. In the Load Configuration File field, use the Browse button to select the file you would like to load.

Performing a Transfer
After setting up and saving the options, you can perform updates at regular intervals without needing to re-
peat the setup process.

To perform a transfer:

1. Select the Review button. The Summary of Selected Options window launches.
2. Review your selected options, then select the OK button to close the window.
3. Select the Update Now button. The transfer will use all settings selected from the General, Select 

Data to Update, Resource Mapping, and Field Mapping tabs.
• For information on the General tab settings, refer to: Selecting General Update Settings on 

page 11.
• For information on the Select Data to Update tab settings, refer to: Selecting Data to 

Update on page 12.
• For information on the Resource Mapping tab settings, refer to: Performing Resource 

Mapping on page 15.
• For information on the Field Mapping tab settings, refer to: Performing Resource Mapping 

on page 15.

Any changes you make to the configuration settings are discarded when you select the Exit or the 
Reset button. Changes to the settings are only saved when you select the Save button, and save your 
current settings to a configuration file.

Selecting the Reset button refreshes the Integration Manager’s connection to Microsoft Project and 
to Web TimeSheet; if you are using a default configuration file, your settings will revert to those saved 
in the file.

To prevent errors when updating from Web TimeSheet to Microsoft Project, ensure the Prompt Be-
fore Saving option is disabled in Microsoft Project. To disable the Prompt Before Saving option, se-
lect Options from the Tools menu. Then, select the Save tab in the Options dialog box and clear the 
Prompt Before Saving check box in the Auto Save section. Close and re-open Microsoft Project.

When updating for the first time, update all hours within the project start and end dates to ensure all 
the necessary data is available in both applications.
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When the transfer is complete, the Integration Manager will notify you if any errors or issues were encoun-
tered during the transfer and give you the option of viewing the log file.

If, according to the MSPIlog.txt log file, your permissions prevented you from updating certain data, 
refer to your Web TimeSheet administrator for more information.

For more information on the Integration Manager log files, refer to Chapter 2, Understanding the Inte-
gration Manager Log Files on page 9.

If you are transferring from Project to Web TimeSheet, do not close a project while it is being trans-
ferred since this will cause that transfer, and every transfer attempted thereafter, to fail. If this occurs, 
restart the integration manager to begin transferring again.

You cannot cancel the transfer process once it has begun. If you choose to close the window before 
the transfer is complete, the partially-transferred data will not revert back to its original state.

When updating projects, only the first ten levels of the hierarchy will be updated.

The first time you update a project from Microsoft Project to Web TimeSheet, a new project with the 
same name used in Microsoft Project will be created in Web TimeSheet, and vice versa.

For information on how the Integration Manager handles transfers involving duplicate user names in 
Web TimeSheet, refer to Understanding how Duplicate Users are Transferred on page 21.
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CHAPTER 4
Mapping Resources

A resource name formula must be defined in the Integration Manager so that:

• When you transfer users and resources between Project and Web TimeSheet, the Integration Man-
ager can match each resource with the correct user.

• If the Integration Manager is creating a new user in the destination application, it can determine 
what format to use when creating the new user’s details.

You can set the resource name formula and other resource transfer settings via the Resource Mapping tab, 
using the fields outlined below.

Setting the Resources Options
Resource Name Formula
Use this field to specify the resource name formula. This formula determines the name format the Integration 
Manager will use to match resources and their corresponding users. You can create a custom name formula, 
or retain the default ($FirstName $LastName). The format options are:

At minimum, the formula must include either $LoginName or both $FirstName and $LastName.

**Use the $Other tag to represent any other text in the resource name that does not correspond to anything 
in Web TimeSheet. You may also include non-text special characters (such as . , ( ) { } [ ] *) that do not map 
to anything in Web TimeSheet.

Create a new user in Web TimeSheet if user does not exist
If a resource you are transferring from Project does not yet exist in Web TimeSheet, you can choose to cre-
ate that user in Web TimeSheet. You must have permission to add new users in Web TimeSheet to carry 
out this transfer.

We recommend selecting this option:

• To ensure that all necessary information is transferred during the update process
• To prevent update delays while you wait for the necessary information to be added.

Allowed Formula Tag... Web TimeSheet field 
mapped to...

$FirstName First Name

$LastName Last Name

$LoginName Login Name

$Other** Does not map.

When transferring from Microsoft Project to Web TimeSheet, ensure that you use the same resource 
name mapping formula. If a resource who was previously transferred to Web TimeSheet is transferred 
again using a different resource name mapping formula, the user will be duplicated in Web TimeSheet 
using the new name format.
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If you enable this option, you must supply the default authentication type and domain (if applicable) that you 
would like assigned to the new user. Only authentication types enabled in Web TimeSheet will be available 
for selection.

Understanding Settings Assigned to Newly-Created Users
The following settings are automatically assigned to new users created in Web TimeSheet.

Setting the Resource Pool Updates Options
The Microsoft Project resource pool is a set of resources that can be shared by several projects, saved in a 
Local resource data file.

Transferring Resource Pool members to Web TimeSheet
To transfer resources from the Microsoft Project resource pool to Web TimeSheet, select the Update Now 
button.

Using Custom Fields when transferring Resources from the Resource Pool
You can set up custom fields in Microsoft Project for use when transferring new users’ from the resource 
pool to Web TimeSheet. You can create and select custom fields for the users’ login name or password.

Type of Setting Each new user created in Web TimeSheet will be assigned...

Permissions Non Exempt - Time and Time Off permission
Project & Billing seat assignment (and Time & Attendance, if available)

Password (if appli-
cable)

The password password

First Name A first name based on the $FirstName from the resource name formula, if avail-
able. If not available, the first name will be set to the $LoginName included in 
the formula.

Last Name A last name based on the $LastName from the resource name formula, if avail-
able. If not available, the first name will be set to the $LoginName included in 
the formula.

Authentication 
type

The authentication type selected in the Integration Manager.

Login name If Windows NT, Active Directory, or SAML authentication are selected, the Win-
dows Account login name value as their Web TimeSheet login name.

If Windows Account is not available, or Web TimeSheet Internal authentication 
is selected, the Web TimeSheet login name will be set to the $LoginName in-
cluded in the formula. If $LoginName is not included in the formula, the login 
name will be set to $FirstName$LastName.

Domain (if applica-
ble)

The domain from the user’s Windows Account, if available. If not available, the 
user will be assigned the domain selected in the Integration Manager.

**This value can be reset manually after transfer if different domains are re-
quired in Web TimeSheet and Project.
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If you do not set up the custom fields, the Integration Manager will assign the login name and password as 
outlined on Understanding Settings Assigned to Newly-Created Users on page 20.

Understanding how Duplicate Users are Transferred
It is possible to create two or more users with the same user name in Web TimeSheet; however, the dupli-
cate users’ login names must be unique.

Refer to the table below for information on how the Integration Manager handles transfers involving dupli-
cated users.

If Windows NT, Active Directory, or SAML authentication are selected in the Integration Manager, the 
login name will be based on the Windows Account value, if available, and not the custom field value.

Microsoft Project does not allow users with the same user name to be created.

If you attempt to transfer... The Integration Manager will...

... users that are duplicated in Web TimeSheet 
to Microsoft Project, when none of the duplicat-
ed users exist in Project

... automatically append, in brackets, the user’s 
login name to their last name in Project. This will 
happen even if only one of the duplicated em-
ployees is transferred.

... users that are duplicated in Web TimeSheet 
(or their data) in either direction, when that em-
ployee’s user name exists – but has not been 
appended with their login name – in Project
Note: This situation may arise if, for example, 
you transferred a user to Project before creating 
a duplicate in Web TimeSheet, or if you created 
a user who was duplicated in Web TimeSheet 
independently in Project (this is not recom-
mended).

... not transfer the duplicated users/data, and an 
error will be logged, since the user’s data in 
Project may correspond to any of the duplicated 
users in Web TimeSheet.
In this case, you may manually append the us-
er’s login name to their last name in Project, and 
then transfer the user/data.
Mapping Resources 21



CHAPTER 5
Modifying Configuration Settings

Use the Configuration tab to modify your configuration settings, as required:

• Your server and login options
For information on this, refer to Modifying your Server and Login Options on page 22.

• Data regarding common resources shared across projects
For information on this, refer to Modifying Resources used across Multiple Projects on page 22.

• Project information, such as which version of Project you are using, and which file or folder con-
tains project data
For information on this, refer to Modifying Project Information on page 23.

• Configuration settings information, such as which previously-saved settings to use, or what set-
tings file should be assigned as default
For information on this, refer to Modifying Configuration Settings Information on page 23.

• What action the Integration Manager should take when an error occurs
For information on this, refer to Modifying the Action the Integration Manager takes when an error 
Occurs on page 24.

Modifying your Server and Login Options
To modify your server and login options, in the Web TimeSheet Server Configuration section:

• Enter (or modify, if desired) the Web TimeSheet URL, which is used to access Web TimeSheet on 
the server.

• Modify your Web TimeSheet Login name or Password, if desired.
• If you want to connect to Web TimeSheet to begin updating data or to test the new connection, 

select the Connect button.
• If you want the Integration Manager to save your Web TimeSheet connection information so you do 

not have to re-enter it next time you log in, enable the Remember this information check box.

Modifying Resources used across Multiple Projects
To modify the configuration of common resources used across projects, in the Resource Pool Configura-
ton section:

1. Select the Local resource data file by using the Browse button.
The resource data file is a Microsoft Project (.MPP) resource pool file that contains information on 
common resources shared across projects. This file must be accessible from the computer you are 
using to perform updates.

2. Select the resource name format the Integration Manager should use to match each user in the re-
source file to the corresponding user in Web TimeSheet. The format options are:

Format Option Example

FirstName LastName (default) Jane Smith

LastName FirstName Smith Jane
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3. You may set up custom fields in Microsoft Project for the Integration Manager to use when transfer-
ring new users’ login names and passwords. Specify the custom fields using these fields:

• Select a custom field for login name
• Select a custom field for password

If you do not set up the custom fields, the Integration Manager will use the following defaults:
• login name – FirstName LastName
• password – password.

4. If you wish to update the resource pool, select the Update Now button in the Resource Pool Con-
figuration section. The update will begin immediately.

Modifying Project Information

Use the Project Folder Configuration section to update project information.

• If you want to change the version of Project you are using, from the Microsoft Project Version 
field, select the new version.

• If you want to modify a Project Folder (Project version 2007) or Project File (Project version 
2003/2002), use the Browse button to locate and select the new file or folder.

Modifying Configuration Settings Information
In the Microsoft Project Configuration section:

Login Name jsmith

If a resource or user has previously been transferred and is transferred again with a different 
Resource Name Mapping selected, the resource/user will be duplicated in the target appli-
cation using the new name mapping.

You can only modify Project information from within the Integration Manager if you are using the stan-
dalone version.

If you change Project versions, a message will display stating that the Integration Manager 
must restart. To change Project versions:

1. Select OK.
2. Select the Save button to save your current configuration.
3. Load the newly-saved configuration file, and set it as the default (by enabling the 

check box).
4. Close the Integration Manager.
5. Open the new version of Project you want to use, and close the old version.
6. Restart the Integration Manager. The updated version of Project will be used.

The Integration Manager will automatically update the Available Projects list on the General 
tab when a new file or folder is selected.

Format Option Example
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• If you want to load the settings from a previously-saved .XML configuration file, use the Browse 
button to locate and select the file.
The Integration Manager will automatically update its configuration settings using those stored in 
the file. For more information on saving configuration settings, see Modifying the Action the Inte-
gration Manager takes when an error Occurs below.

• Enable the Use this file as the default Configuration check box if you would like the selected 
configuration file to load by default when the Integration Manager is launched.

Modifying the Action the Integration Manager takes when an error 
Occurs
To modify the action the Integration Manager takes when an error occurs:

In the Prompt Message Options section, in the When error occurs during data transfer field, select the 
action the Integration Manager should take when an error occurs. The options are described in the following 
table:

If you do not enable this check box, each time you start the Integration Manager you will need 
to select the Project Folder (Project version 2007) or Project File (Project version 2003/
2002) configuration file again.

Option The Integration Manager...

Prompt ... prompts you to choose between continuing and aborting the 
transfer

Continue Transfer ... automatically continues the transfer

Abort Transfer ... automatically aborts data transfer
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CHAPTER 6
Field Relationships

On the following pages, the field mappings available when transferring from Web TimeSheet to Microsoft 
Project and when transferring from Microsoft Project to Web TimeSheet are provided.

Important Notes on Mapping Fields
Keep the following in mind when selecting field mappings:

• If you are using:
• Microsoft Project 2003/2002, only custom fields that are available across all projects in the 

Microsoft Project database file (.MPD file) are available for mapping.
• Microsoft Project 2007, only custom fields that are available across all projects (.MPP files) 

in the Microsoft Project folder are available for mapping.
• Calculated Microsoft Project custom fields cannot be mapped to Web TimeSheet user defined 

fields because Web TimeSheet user defined fields cannot perform calculations.
• Mapping between Web TimeSheet user defined fields and Microsoft Project custom fields is 

dependent on the field type. This means that data transfer may fail if the data types are not compat-
ible. For example, a number field cannot successfully transfer data to a date field; however, a num-
ber field can successfully transfer data to a text field.

Available Mappings from Web TimeSheet to Microsoft Project
Web TimeSheet Field (source) Microsoft Project Field 

(target)

Project Description Project Category
Project Keyword
Project Subject
Project Title
Project Comments
Project Author
Project Company

Project Code Project Category
Project Keyword
Project Subject
Project Title

Project Client Project Company

Task Code Custom Fields (Task Type)

Task Estimated Hours Task Work

Task Estimated Cost Task Cost
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Available Mappings from Microsoft Project to Web TimeSheet

Note:
• Microsoft Project allows entry of the estimated cost only at the bottom level of the project/task 

structure, therefore you should not enter estimated cost values for any parent projects/tasks in 
Web TimeSheet. Values entered for higher level tasks will not be included in the update pro-
cess.

• Turn on the Project/Task Roll-up feature in Web TimeSheet before the first update is per-
formed from Microsoft Project to Web TimeSheet.

• The method Project uses to calculate Task Cost results in an inaccurate Task Cost value in 
Project if, during the same update, you transfer both:

• One or more new resource assignments, AND
• Task Estimated Cost to Task Cost

To prevent this inaccuracy, transfer new resources and cost mapping for a task in separate 
updates.
If you have already transferred cost mapping and new resources for a task in a single update, 
retransfer the project from Web TimeSheet to Microsoft Project using the same mapping to 
correct the data inaccuracy.

Task Description Custom Fields (Task Type)

User Rate Resource Standard Rate

User Hourly Cost Resource Standard Rate

User Default Billing Rate Resource Standard Rate

Task Level User Defined Fields (Proj/Task Catego-
ry)

Custom Fields (Task Type)

Note: If you attempt to map task level user defined fields to a single project level field in Microsoft Project, 
the field data will not be updated and an error will appear in the update log file. This occurs because tasks 
may potentially have multiple values for the selected field and can therefore not be mapped to the project 
field, which can only receive one value. 

Project Level User Defined Fields (Proj/Task Cate-
gory)

Project Category
Project Keyword
Project Subject
Project Title
Project Comments
Project Author
Project Company

User Defined Fields (User Category) Custom Fields (Resource Type)

Microsoft Project Field (source) Web TimeSheet Field 
(target)

Project Keyword Project Code
Project Description
Project Level User Defined Fields (Proj/Task Cate-
gory)

Web TimeSheet Field (source) Microsoft Project Field 
(target)
Field Relationships 26



Project Title Project Code
Project Description
Project Level User Defined Fields (Proj/Task Cate-
gory)

Project Subject Project Code
Project Description
Project Level User Defined Fields (Proj/Task Cate-
gory)

Project Category Project Code
Project Description
Project Level User Defined Fields (Proj/Task Cate-
gory)

Project Comments Project Description
Project Level User Defined Fields (Proj/Task Cate-
gory)

Project Company Project Client

Project Work Project Estimated Hours
Project Level User Defined Fields (Proj/Task Cate-
gory)

Project Cost Project Estimated Cost
Project Level User Defined Fields (Proj/Task Cate-
gory)

Project Actual Hours Project Level User Defined Fields (Proj/Task Cate-
gory)

Task WBS Code Task Description
Task Code
Task Level User Defined Fields (Proj/Task Catego-
ry)

Task Duration Task Estimated Hours
Task Level User Defined Fields (Proj/Task Catego-
ry)

Task Work Task Estimated Hours
Task Level User Defined Fields (Proj/Task Catego-
ry)

Task Cost Task Estimated Cost
Task Level User Defined Fields (Proj/Task Catego-
ry)

Task Priority Task Level User Defined Fields (Proj/Task Catego-
ry)

Task Unique ID Task Code
Task Level User Defined Fields (Proj/Task Catego-
ry)

Microsoft Project Field (source) Web TimeSheet Field 
(target)
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% Complete Project Level User Defined Fields (Proj/Task Cate-
gory)
Task Level User Defined Fields (Proj/Task Catego-
ry)

Microsoft Project File Name Project Description
Project Level User Defined Fields (Proj/Task Cate-
gory)

Note: If you map the Microsoft Project file name to a User Defined Field, only the specified User Defined 
Field for the project (not the task) will be updated. 

Custom Fields (Task Type) Task Description
Task Code
Task Estimated Cost
Task Estimated Hours
Task Level User Defined Fields (Proj/Task Catego-
ry)

Note: When you map from Microsoft Project custom fields to Web TimeSheet User Defined Fields, cal-
culated fields are excluded.

Custom Fields (Resource Type) User Defined Fields (User Category)

Note: When you map from Microsoft Project custom fields to Web TimeSheet User Defined Fields, cal-
culated fields are excluded.

Microsoft Project Field (source) Web TimeSheet Field 
(target)
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CHAPTER 7
Recommended Practices and Additional Notes

Recommended Practices
You should use the following recommended practices when transferring data between Web TimeSheet and 
Microsoft Project.

If you are a Microsoft Project user integrating with Web TimeSheet for the first time:

• Use Microsoft Project to create and maintain your project profile/project information
• Transfer the projects from Microsoft Project to Web TimeSheet
• Enter time against the projects in Web TimeSheet
• Only change the project information in Microsoft Project

If you are a Web TimeSheet user integrating with Microsoft Project for the first time:

• Transfer any existing Web TimeSheet project information to Microsoft Project for the first time only

• Following this initial transfer of project information, update the projects in Microsoft Project and 
transfer the updated projects from Microsoft Project back to Web TimeSheet

• Use Web TimeSheet to enter time and transfer only time to Microsoft Project

Notes on Working with Embedded and Externally Linked Projects
There are special considerations when working with projects created in Microsoft Project Standard/Profes-
sional that contain embedded projects or externally linked tasks.  When working with a project in which a 
second project is embedded, keep in the mind the following:

• Avoid changing the structure and resource assignments within the project using Web TimeSheet.  
If you wish to make changes, do so in Microsoft Project only and then transfer the updated informa-
tion to Web TimeSheet.

• If there is a resource with the same name both in the main project and the project embedded within 
it, the Integration Manager considers those resources as identical.

• The currency symbol used by each project affects the operation of the Integration Manager as fol-
lows:

• If the main and embedded projects are set to use different currency symbols, data transfer 
will not occur and the Integration Manager will log an error.

• If the main project has no currency symbol associated with it and the embedded project’s 
currency symbol matches that of the regional settings, data will be transferred successfully.  
If the embedded project’s currency symbol does not match the regional settings, data 
transfer will fail and the Integration Manager will log an error.

• If the embedded project has no currency symbol associated with it, data will be transferred 
successfully, regardless of the main project’s currency symbol.

When working with a project in Microsoft Project that includes tasks that are linked externally, that is to a 
task within another project, note the following:

• The task to which the external link has been made can be transferred from Microsoft Project to 
Web TimeSheet.  However, when transferring back to Microsoft Project, data for the externally 
linked task will not be transferred as Microsoft Project does not allow the embedded task to be 
edited within the main project.  A message will be logged by the Integration Manager in the log file 
when this occurs.
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• Do not name the externally linked task with the same name as a task present at the same level in 
the main project.  If the externally linked task has the same task name as another task, only one of 
the tasks will be transferred to Web TimeSheet, as Web TimeSheet does not allow two tasks of the 
same name at the same level.  The task which appears first in Microsoft Project is the one that is 
transferred to Web TimeSheet.  As a result, when transferring data back to Microsoft Project:

• If the externally linked task appears first in Microsoft Project, it is the one that is transferred 
to Web TimeSheet.  When transferring data back to Microsoft Project, both tasks of the 
same name are deleted from within the project.

• If the externally linked task appears second in Microsoft Project, the original task is the one 
that is transferred to Web TimeSheet.When transferring data back to Microsoft Project, the 
externally linked task will be deleted from Microsoft Project, but the original task will remain 
intact.

Notes on Transferring Time Data with Web TimeSheet Billing Rates 
Selected
Within Web TimeSheet, users can select a billing rate when entering time against a task.  However, when 
transferring time entries from Web TimeSheet, Microsoft Project does not support transfer of the associated 
billing rates.  If you are tracking costs for the project in Microsoft Project, it is important to note that the Web 
TimeSheet billing rates will not be reflected in the cost data.  However, the Integration Manager does support 
mapping of Web TimeSheet values to the Microsoft Project Resource Standard Rate, which can be used 
for cost tracking purposes, if desired.

Additionally, Web TimeSheet allows users to select more than one rate when entering time against a task. 
When these time entries are transferred, the total of all hours entered for the task, regardless of the billing 
rate selected, will be transferred to Microsoft Project.  For example, if 5 hours are entered against Task 1 
using the Project Manager rate and 3 hours are entered against Task 1 using the Administration 
rate, 8 hours will be transferred to Microsoft Project for Task 1.

Troubleshooting Tips
The following sections are designed to assist you in resolving issues that you may encounter when using 
the Integration Manager.

Deleted Task Still Exists in Web TimeSheet after Update
If you have deleted a task in Microsoft Project and the corresponding task has not been deleted in Web 
TimeSheet after an update, verify that the task is not selected on any users’ timesheets.  If the task has been 
selected on a user’s timesheet, Web TimeSheet prevents the task from being deleted, even if no time has 
been entered against it.  Have the user select another task or delete the timesheet row and then save the 
timesheet.  Update Web TimeSheet using the Integration Manager again and the task should be deleted 
from within Web TimeSheet.  If the problem persists, contact Replicon’s Customer Support team as detailed 
in Contacting Support on page 6.
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